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Prepare for Installation

Prepare for the Installation of Connect:Direct for Windows

Before you install Connect:Direct for Windows, make sure the following tasks are complete:

• Make sure system meets product hardware and software requirements
• Define users for Windows
• Configure and test TCP/IP or SNA connectivity as needed
• Install and configure SQL Server or SQL Server Express for database support
• Install and configure SNMP as needed
• If you plan to use NT Broadcast to send user notification messages, ensure that NT Broadcast is configured
• Complete installation worksheets

Requirements for Copying Files To and From Network Servers

When you are ready to create Processes, be aware that Connect:Direct allows you to share information across
computers. All of the data does not have to be on the Connect:Direct server. Observe the following requirements
to enable copying files among network servers:

• Files to copy must reside on a file server accessible by Connect:Direct for Windows.
• You must provide a valid user ID and password for the file server where the files reside. Use a local node

ID when you submit a Process on the local node and a remote node ID when you submit a Process on a remote
node. Supply information as part of the process statement or the submit command or use the Login Connection
Utility to provide this information.

• If a Process has multiple copy steps, the local node ID or remote node ID parameter must be appropriate for
each file server from which, or to which you transfer a file. This method is necessary because the parameters
apply to the Process as a whole and not to individual copy steps.

• Specify the Universal Naming Convention (UNC) form of the file name if the file is not on a drive directly
connected to the same Windows server as Connect:Direct. If the file is on the Windows server where
Connect:Direct is installed, you can specify the drive letter. The UNC name format is:

\\servername\share point name\filename
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• The servername is the Windows server where data resides.
• The share point name is the name under which the remote Windows server shares the directory you want

to access.
• The filename specifies the name of the file and any subdirectories.

Configure Windows User Privileges

Connect:Direct for Windows must be installed by a Windows administrator. However, ongoing administration
only requires that the administrator is a member of the Windows Users group and is defined in the Connect:Direct
User Authorities with administrative privileges based on the admin template.

After Connect:Direct for Windows is installed, attach to Connect:Direct for Windows as sysadmin and add a
user as a Connect:Direct for Windows administrator (for example, cdadmin) with the user right, Log on locally.
Then, delete sysadmin from the Connect:Direct for Windows User Authorities.

Refer to Microsoft Windows system documentation for instructions on setting up an administrator account.
Refer to the Connect:Direct for Windows System Guide for information on configuring user authorities.

Customize a Connect:Direct Logon Account

Connect:Direct for Windows is installed under the local System account.

To create a custom account, assign the account the following privileges:

• Log on as service—Set this privilege to allow a Windows service to run in the context of the specified user
instead of running in the context of the local system account.

• Replace a process level token—Turn on this privilege to allow Connect:Direct for Windows to submit
Processes on behalf of logged on users.

• Be a member of the Local Administrator Group—If you want to allow the node to update its entry in Active
Directory, the account must also be a member of the Enterprise Admin group.

• Secure+ directory—Give the account full permissions to the Secure+ directory.

Note: These privileges are stored locally, even if the computer is a member of a domain. As a result, privileges
cannot be set on the domain controller and granted to all computers on the domain.

Note:  Enabling the option, Allow service to interact with desktop when running Connect:Direct under the
local System account, presents a security risk and may allow access to services that interact with the desktop.

After you create the account, you assign it as the account for Connect:Direct. To identify the custom logon
account:

1. Select Start > Settings > Control Panel > Administrative Tools > Services.

2. Double-click the Connect:Direct server.

3. Click the Log On tab.

4. Select This account to identify the custom logon account.

5. Type the account name to use for logging onto Connect:Direct, or click Browse and double-click the user
account.

6. Type the password in the Password and Confirm password fields.
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7. Click OK.

Configure TCP/IP Connectivity

To enable TCP/IP connectivity, configure each computer with a valid IP address, IP subnet, and IP gateway.
If the communications partner is on another subnet or network and a firewall is between the communications
partner and the Windows computer, verify that the Access Control Lists (ACLs) are correctly configured.
Contact your Firewall/Security Administrator for more information on configuring the ACLs for your firewall.

Connect:Direct for Windows Installation Worksheet

Complete this worksheet before you install Connect:Direct for Windows.

Additional InformationChoicesDecision

What Connect:Direct software to install? • Connect:Direct Requester
• Connect:Direct Server
• Connect:Direct Secure+ Option

Choose the installation directory (where
X represents the drive letter.)

• Accept the default installation directory
- X:\Program Files\Sterling
Commerce\Connect:Direct 4.5.00

• Change the installation directory
• Install on a network drive
• Place an icon on a desktop to perform

the installation the first time the
application is opened.

Note: To change the local node name
after the product is installed, you must
reinstall Connect:Direct for Windows.

Name the Connect:Direct node - The
default local node name is the name of
the Windows computer.

You will also need to identify the
number of sessions you are licensed
for.

Location of the license management
file.

If security is implemented on Microsoft
SQL Server—Windows Authentication,

Identify the database software • SQL Express Server
• Microsoft SQL Server—Windows

Authentication create a valid user ID and password and
a CREATE TABLE privilege within the
database.

Identify Node-to-Node IP Address,
Node-to-Node Port, User Interface IP
Address, User Interface Port

Identify TCP/IP communication
information

Identify Node-to-Node IP Address,
Node-to-Node Port, User Interface IP
Address, User Interface Port

Identify UDT communication information
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Additional InformationChoicesDecision

Identify additional components • APPC Connectivity - SNA. Identify LU
Name, Net ID, Mode Name.

• Process Notification. Specify NT
Broadcast or SMTP. If SMTP, specify
Host Address, Host Port (default is
25), and Sender.

• Load an Existing Network Map.
Identify the fully qualified pathname
for the MAP.CFG.

• Load Existing User Authorities. Identify
the Fully qualified pathname for the
USER.CFG.

Install and Configure Database Software

The database logs Process statistics, internal messages, and the Process control queue. Determine which
software to use as the database software.

• To use SQL Server, install it on the local computer, a network drive, or remote computer accessible from the
local Connect:Direct node.

• To use SQL Server Express, run the SQLServer2008ExpressSP1.exe program located in the CD NT v. 4.5.01
\Server and Requester folder.

Automate the Connect:Direct for Windows Installation

You can automate Connect:Direct for Windows installations using an initialization (INI) file. Implement
automated installations by specifying a path to the INI file from the command line of the Windows setup. See
About Silent Installations for information about automating installations.

Configure SNA Connectivity

If you plan to use SNA network communications connectivity with Connect:Direct, install and configure SNA
before installing Connect:Direct for Windows. Use the SNA Configuration Worksheet to identify the parameters
necessary to configure SNA.

In addition, create an active connection between the local and remote nodes. Connect:Direct for Windows
requires the following information for the local and remote SNA networks in order to configure a peer- or
host-based partner SNA connection:

• Network name
• Mode name (local system only)
• Control point name
• Node ID
• Network address (remote system only)
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• LU name and LU alias name (these names may be the same value; Connect:Direct uses the LU alias name)

Note:  Connect:Direct for Windows supports only independent LU6.2.

Refer to the SNA Server/Host Configuration Worksheet when mapping SNA connection parameters between
Connect:Direct for Windows and a host system.

Note:  Consult the SNA product documentation or contact your SNA vendor for any questions about configuring
the SNA communications software.

SNA Configuration Worksheet

Use this worksheet to identify the parameters necessary to configure SNA. Make copies of this worksheet for
each SNA configuration. See the z/OS Network Map Example for VTAM for SNA Server configuration examples.

Additional InformationInformation NeededNode

The LU Alias name is a user-defined
name that references the LU name

Decide the following:
Local Node

• Connect:Direct Node Name
defined in the local SNA network. This

• LU Alias Name value can be the same as the actual LU
name.Get the following information from your

SNA administrator:

• LU Name
• Network Name
• Mode Name
• Control Point Name
• Node ID

The LU Alias name is a user-defined
name that references the LU name

Get the following information from your
trading partner:

Remote Node

defined in the remote SNA network.• Connect:Direct Node Name
This value can be the same as the

• LU Alias Name actual LU name. Obtain that information
Get the following information from your
SNA administrator:

from the SNA administrator of the
remote system.

• LU Name
• Network Name
• Control Point Name
• Node ID
• Network Address

Sample SNA Configuration
This section illustrates a sample SNA configuration used to connect to Connect:Direct for z/OS. You provide
the following SNA resource definitions during the Microsoft SNA configuration. These values are derived
from VTAM definitions supporting connections between Connect:Direct for z/OS and Connect:Direct for
Windows. Contact the VTAM administrator for the values you need to specify during SNA configuration.
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z/OSParameter ValueWindows

=APPLID= M1CDXY2BRemote LU Name

=LU NAME= M1R01LUALocal LU Name

=NETID= CSDNETNetwork Name

=MODEENT= NDM624KMode Name

=SSCPNAME= CSDSA01Remote Control Point Name

=PU NAME= M1RPU01Local Control Point Name

=ADJACENT.NODE= SS.DUB.USER1Local Connect:Direct Node Name

=LOCAL.NODE= CDNT0001Remote Connect:Direct Node Name

=XID= 0716200DLocal Node ID

=MAC Address= 4000 7000 6200Remote Network Address

Sample Connect:Direct for z/OS Network Map Entries

The following sample illustrates Connect:Direct for z/OS network map entries for Windows SNA software
running Connect:Direct for Windows.

*****************************************************************
*                                                               *
*                   Connect:Direct NETWORK MAP                  *
*                                                               *
*****************************************************************
*                                                               *
*****************************************************************
* LOCAL NODE                                                    *
*****************************************************************
LOCAL.NODE    =  ((SS.DUB.USER1 M1CDXX2B,, SUPERUSR)          -
           TCQ=  (USER1.R210.TCX                              -
                 USER1.R210.TCQ)                  )
*
ADJACENT.NODE = (PARSESS = (10  2)                            -
                (CDNT0001, M1R01LUA, LU62)                  -
                ENVIRONMENT=NT                              -
                LOGMODE=NDM624K                        )

XCA Token Ring: Switched Net Definitions

The following sample illustrates the major node definitions for an XCA device.

***************************************************
*                                                           *
*                                                           *
*XCA TR   DEFINITION                                        *
*                                                           *
*                                                           *
*CHANGE LOG                                                 *
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*                                                           *
*************************************************** 
M1R01PU  VBUILD TYPE=SWNET,                                           X
            MAXGRP=1,              MAXIMUM NUMBER OF UNIQUE GRPNM     X
             MAXNO=1               MAXIMUM NUMBER OF UNIQUE DIALNO
*
***
M1RPU01  PU    ADDR=01,                                               X
                       PUTYPE=2,                                      X
                       ISTATUS=ACTIVE,                                X
                       DBLK=071,                                      X
                       IDNUM=6200D,                                   X
                       PASSLIM=8,                                     X
                       DLOGMOD=NDM624K,                               X
                       MODETAB=DALLMTAB,                              X
                       SSCPFM=USSSCS,                                 X
                       USSTAB=LSUSSTAB,                               X
                       PACING=7,                                      X
                       VPACING=7,                                     X
                       DISCNT=(NO),                                   X
                       MAXDATA=521,                                   X
                       MAXPATH=2,                                     X
                       MAXOUT=8
*
M1RPTH0D PATH  GRPNM=M1XG516D,                                        X
                       DIALNO=0011111111111D  DUMMY
*M1ROLUA LU LOCADDR=0, DLOGMODE=NDM6241C
*3270
*
M1R01LU2 LU  LOCADDR=2,DLOGMOD=D4A3290
M1R01LU3 LU  LOCADDR=3,DLOGMOD=D4A3290
*
*LU 6.2 ILU
*

XCA Token Ring: Independent LU Definition

The following sample illustrates the Independent LU definitions included as Cross Domain Resources.

******************************************************************
 VTAM 3.4 CDRSC DEFINITIONS FOR INDEPENDENT LU'S                          *
* 6.2 ILU DEFINITION - XCA TR ACCESS                                      *
*CHANGE LOG:                                                              *
*                                                                         *
*                                                                         *
*                                                                         *
******************************************************************
M1R01CDS VBUILD TYPE=CDRSC
*
M1R01CDS VBUILD TYPE=CDRSC
           ALSLIST=M1RPU01,       ADJ LINK STATION                        X
           MODETAB=DALLMTAB,      LOGON MODE TABLE                        X
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           DLOGMOD=NDM624K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5 SESSION CONTROL BLOCKS
M1R01LUB CDRSC ISTATUS=ACTIVE,                                            X
           ALSLIST=M1RPU01, ADJ LINK STATION                              X
           MODETAB=DALLMTAB, LOGON MODE TABLE                             X
           DLOGMOD=NDM624K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5               SESSION CONTROL BLOCKS
*
M1R01LUB CDRSC ISTATUS=ACTIVE,                                            X
           ALSLIST=M1RPU01,       ADJ LINK STATION                        X
           MODETAB=DALLMTAB,      LOGON MODE TABLE                        X
           DLOGMOD=NDM624K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5               SESSION CONTROL BLOCKS
*
M1R01LUC CDRSC ISTATUS=ACTIVE,                                            X
           ALSLIST=M1RPU01,       ADJ LINK STATION                        X
           MODETAB=DALLMTAB,      LOGON MODE TABLE                        X
           DLOGMOD=NDM622K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5               SESSION CONTROL BLOCKS
*
M1R01LUD CDRSC ISTATUS=ACTIVE,                                            X
           ALSLIST=M1RPU01,       ADJ LINK STATION                        X
           MODETAB=DALLMTAB,      LOGON MODE TABLE                        X
           DLOGMOD=NDM621K,       LOGON MODE TABLE ENTRY                  X
           RESSCB=5               SESSION CONTROL BLOCKS
*

XCA Token Ring: Major Node Definition

The following sample illustrates the major node definitions for an XCA device.

*****************************************************************
*                                                               *
* XCA MAJOR NODE                                                *
*                                                               *
* CHANGE LOG:                                                   *
*****************************************************************
M1XCA516 VBUILD TYPE=XCA        XCA MAJOR NODE
*
M1XP5161 PORT  MEDIUM=RING,     TOKEN-RING                      X
               SAPADDR=4,       SERVICE ACCESS POINT ADDRESS    X
               ADAPNO=0,        ADAPTER NUMBER                  X
               CUADDR=516       CHANNEL UNIT ADDRESS
*
M1XG516D GROUP DIAL=YES,        SWITCHED PERIPHERAL NODE        X
               CALL=IN,         DIAL IN AS PER MCDATA           X
               ISTATUS=ACTIVE   ACTIVATED AT GEN
*
M1XL516D LINE  ANSWER=ON        PU CAN DIAL IN
*
M1X516PD PU
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*
***

Sample Connect:Direct APPLDEF

The following sample illustrates the application definitions for Connect:Direct for z/OS.

ZZAPPGLP VBUILD TYPE=APPL
*****************************************************************
*         C:D z/OS TEST LU 6.2 ILU APPL DEFINITION              *
*                                                               *
*****************************************************************
*
M1CDXY2B APPL ACBNAME=M1CDXY2B,    VTAM APPLID                  X
            APPC=YES,          LU 6.2 CAPABLE                   X
            AUTH=(ACQ,VPACE),  VTAM AUTHORITY FOR THIS APP      X
            AUTOSES=10,        # OF AUTO CONT WINNER ACTIVATES  X
            DDRAINL=ALLOW,     DRAIN ALLOWED FOR CNOS 0         X
            DLOGMOD=NDMLM1K,   DEFAULT MODE TABLE ENTRY         X
            DMINWNL=10,        MIN CONT WINNER FOR LOCAL LU     X
            DMINWNR=10,        MIN CONT WINNER FOR REMOTE LU    X
            DRESPL=ALLOW,      APPL WILL DO SESSION DEACTIVATES X
            DSESLIM=20,        MAX # OF ALLOWED SESS FOR MODE   X
            EAS=509,           APPROX # OF CONCURRENT SESSIONS  X
            MODETAB=DALLMTAB,  MODE TABLE NAME                  X
            VPACING=7          DEFAULT RECEIVE PACING VALUE
*

Sample Connect:Direct MODEENTS (Mode Definitions)

The following sample illustrates the mode definition entries for an independent LU.

*****************************************************************
*                                                               *
*                      LU 6.2 WITH 4K RU’S                      *
*                                                               *
*****************************************************************
NDM624K  MODEENT LOGMODE=NDM624K,                             *
               TYPE=1,                                        *
               COS=NDMCOS1,                                   *
               FMPROF=X’13’,                                  *
               TSPROF=X’07’,                                  *
               PRIPROT=X’B0’,                                 *
               SECPROT=X’B0’,                                 *
               PSNDPAC=X’04’,                                 *
               SRCVPAC=X’04’,                                 *
               SSNDPAC=X’04’,                                 *
               COMPROT=X’D0B1’,                               *
               RUSIZES=X’8989’,                               *
               PSERVIC=X’060200000000000000000300’            *
*                        0 1 2 3 4 5 6 7 8 9 1011             
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*****************************************************************
*                                                               *
*                      LU 6.2 WITH 2K RU’S                      *
*                                                               *
*****************************************************************
NDM622K  MODEENT LOGMODE=NDM622K,                             *
               TYPE=1,                                        *
               COS=NDMCOS1,                                   *
               FMPROF=X’13’,                                  *
               TSPROF=X’07’,                                  *
               PRIPROT=X’B0’,                                 *
               PSNDPAC=X’04’,                                 *
               SRCVPAC=X’04’,                                 *
               SSNDPAC=X’04’,                                 *
               SECPROT=X’B0’,                                 *
               COMPROT=X’D0B1’,                               *
               RUSIZES=X’8888’,                               *
               PSERVIC=X’060200000000000000000300’            *
*                        0 1 2 3 4 5 6 7 8 9 1011     
*****************************************************************
*                                                               *
*                      LU 6.2 WITH 1K RU’S                      *
*                                                               *
*****************************************************************
NDM621K  MODEENT LOGMODE=NDM621K,                             *
               TYPE=1,                                        *
               COS=NDMCOS1,                                   *
               FMPROF=X’13’,                                  *
               TSPROF=X’07’,                                  *
               PRIPROT=X’B0’,                                 *
               PSNDPAC=X’04’,                                 *
               SRCVPAC=X’04’,                                 *
               SSNDPAC=X’04’,                                 *
               SECPROT=X’B0’,                                 *
               COMPROT=X’D0B1’,                               *
               RUSIZES=X’87

Sample VTAM Start Options (ATCSTRxx)

The following sample represents the VTAM Start Option entries for NETID and SSCPNAME.

*****************************************************************
*                                                               *
*                   z/OS VTAM START DEFINITION                  *
*                                                               *
*****************************************************************
HOSTSA=01,                                                    X
NODETYPE=NN,                                                  X
CONNTYPE=LEN,                                                 X
CPCP=YES,                                                     X
GWSSCP=YES,                                                   X
NETID=CSDNET,                                                 X
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SSCPID=15015,                                                 X
SSCPNAME=CSDSA01,                                             X
LISTBKUP=DEFAULTS,                                            X
TNSTAT,NOCNSL,TIME=60,                                        X
PPOLOG=YES,                                                   X
XNETALS=YES,                                                  X
NCPBUFSZ=2048,                                                X
HOTIOTRM=50,                                                  X
IOPURGE=5M,                                                   X
MSGLEVEL=V4R1,                                                X
MAINTLVL=9311,                                                X
IOBUF=(750,320,50,,30,100,3000),                              X
CRPLBUF=(500,,0,,25,1),                                       X
LFBUF=(300,,0,,32,1),                                         X
LPBUF=(80,,0,,12,1),                                          X
SFBUF=(40,,0,,34,1),                                          X
SPBUF=(32,,0,,32,1),                                          X
BSBUF=(600,,0,,25,50),                                        X
XDBUF=(55,,0,,5,1)

z/OS Network Map Example for VTAM

The following sample illustrates the use of the VTAM parameters (identified by the alphabetic characters
inside brackets) in a z/OS network map.

LOCALNODE=                        ADJACENT.NODE=(
       (node name[b],                       (node name[a],

communications name[o],,             communications name[m],,
superuser password)                  LU62)

       TCQ=(tcxdsn, tcqdsn))                PARSESS=(max[d], default)
                                            ENVIRONMENT=NT
                                            LOGMODE=logmode entry name[c])

Refer to the platform-specific Connect:Direct installation and administration guides for network map information
on other host platforms.

Windows Network Map Example

The following sample illustrates the use of the SNA parameters (identified by alphabetic characters in brackets)
in a Windows network map.

CREATE_SNA_MODE Name(mode [c])
MAXRUsize (MaxRU [e]) MaxPacingSize(7) MaxNetSessLimit(8)
CREATE_SNA_COMMPATH Name(commpathname)
Transport(transport-type) Adapter(0) Address(000000000000)
NetId(netid[f]) PUName() LUName(LUName [m])
ProfileName() LULocAddr(0) Mode(mode[c]) LUSessLimit(8)
CREATE_REMOTENODE Name(remotenodename [b])
LRetry(10) LRetryTime(180) Sretry(10) SretryTime(10) SessPnodeMax(32)
SessSnodeMax(32) DefaultClass(1) RemoteOSEnv(OS/390) NetName(NetName[f])
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PartnerName(PartnerName[o]) TPName(NNV2DTF) Mode(mode[c]) CommPath(commpathname)

Access SNA Server Configuration Listing

Use the following Windows SNA Server command to display the configuration and redirect the information
to a file:

snacfg /print>filename

The following sample illustrates the Microsoft SNA server configuration listing for a configured Windows
server using the values listed in the VTAM Sample Definitions:

MODE #INTER /ADD                              \
   /SESSIONLIM:8                              \
   /CONWIN:4                                  \
   /CONLOSE:0                                 \
   /AUTOACT:0                                 \
   /AUTOPARTNER:No                            \
   /HIGHPRIORITY:Yes                          \
   /PACESENDCNT:7                             \
   /PACERECVCNT:7                             \
   /MAXSENDRU:1024                            \
   /MAXRECVRU:1024                            \
   /MAXSENDRU:1024                            \
   /COMMENT:"Interactive"                     \
MODE #BATCH /ADD                              \
   /SESSIONLIM:8                              \
   /CONWIN:4                                  \
   /CONLOSE:0                                 \
   /AUTOACT:0                                 \ 
   /AUTOPARTNER:No                            \
   /HIGHPRIORITY:No                           \
   /PACESENDCNT:3                             \
   /PACERECVCNT:3                             \
   /MAXSENDRU:1024                            \
   /MAXRECVRU:1024                            \
   /MAXSENDRU:1024                            \
   /MAXSENDRU:1024                            \
   /COMMENT:"Batch"                           \
MODE #BATCHSC /ADD                            \
   /SESSIONLIM:8                              \
   /CONWIN:4                                  \
   /CONLOSE:0                                 \
   /AUTOACT:0                                 \
   /AUTOPARTNER:No                            \
   /HIGHPRIORITY:No                           \
   /PACESENDCNT:3                             \
   /PACERECVCNT:3                             \
   /MAXSENDRU:1024                            \
   /MAXRECVRU:1024                            \
   /MAXSENDRU:1024                            \
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   /MAXSENDRU:1024                            \
   /COMMENT:"Batch"                           \
MODE BLANK /ADD                               \
  /SESSIONLIM:8                               \
  /CONWIN:4                                   \
  /CONLOSE:0                                  \
  /AUTOACT:0                                  \
  /AUTOPARTNER:No                             \
  /HIGHPRIORITY:No                            \
  /PACESENDCNT:3                              \
  /PACERECVCNT:3                              \
  /MAXSENDRU:1024                             \
  /MAXRECVRU:1024                             \
  /MAXSENDRU:1024                             \
  /MAXSENDRU:1024                             \
  /COMMENT:"8 Blank chars"                    \

MODE QPCSUPP /ADD                             \
  /SESSIONLIM:64                              \
  /CONWIN:32                                  \
  /CONLOSE:0                                  \
  /AUTOACT:0                                  \
  /AUTOPARTNER:Yes                            \
  /HIGHPRIORITY:Yes                           \
  /PACESENDCNT:7                              \
  /PACERECVCNT:7                              \
  /MAXSENDRU:1024                             \
  /MAXRECVRU:1024                             \
  /MAXSENDRU:1024                             \
  /MAXSENDRU:1024                             \
  /COMMENT:"5250 Mode"                        \
MODE NDM624K /ADD                             \
  /SESSIONLIM:20                              \
  /CONWIN:10                                  \
  /CONLOSE:10                                 \
  /AUTOACT:0                                  \
  /AUTOPARTNER:No                             \
  /HIGHPRIORITY:No                            \
  /PACESENDCNT:7                              \
  /PACERECVCNT:7                              \
  /MAXSENDRU:4096                             \
  /MAXRECVRU:4096                             \
  /MAXSENDRU:4096                             \
  /MAXSENDRU:4096                             \
  /COMMENT:" "                                \
SERVER CSD-PUBS /ADD                          \
  /CPNAME:M1RPU01                             \
  /NETNAME:CSDNET                             \
  /COMMENT:""                                 \
LINK SNADLC1 /ADD                             \
  /SERVER:CSD-PUBS                            \
  /LINKTYPE:Token                             \
CONNECTION TOKEN1 /ADD                        \
  /SERVER:CSD-PUBS                            \
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  /COMMENT:"802.2 Connection"                 \
  /ACTIVATION:OnServerStartup                 \
  /CALLDIRECTION:Both                         \
  /LOCALBLOCKNO:071                           \
  /LOCALNODENO:6200D                          \
  /CPNAME:CSDSA01                             \
  /NETNAME:CSDNET                             \
  /REMOTEBLOCKNO:                             \
  /REMOTENODENO:                              \
  /LINKSERVICE:SNADLC1                        \
  /REMOTEEND:Host                             \
  /CONNTYPE:802.2                             \
  /XIDTYPE:Format3                            \
  /REMOTENETADDR:400070006200                 \
  /REMOTESAPADDR:4                            \

/MAXBTULEN:1929                               \
  /RECEIVEACKTHRESH:2                         \
  /NAKSENDLIMIT:8                             \
  /RETRYLIMIT:10                              \
  /XIDRETRIES:3                               \
  /T1TIMEOUT:Default                          \ 
  /T2TIMEOUT:Default                          \
  /TITIMEOUT:Default                          \
  /ACTIVATEDELAY:Default                      \
  /ACTIVATERETRYLIMIT:None                    \
APPCRLU M1CDXY2B /ADD                         \
  /CONNECTION:TOKEN1                          \
  /NETNAME:CSDNET                             \
  /LUNAME:M1CDXY2B                            \
  /COMMENT:""                                 \
  /UNINTERPNAME:M1CDXY2B                      \
  /AUTOPARTNER:No                             \
  /PARALLELSESS:Yes                           \
APPCLLU M1R01LUA /ADD                         \
  /SERVER:CSD-NTSNA1                          \
  /LUNUMBER:0                                 \
  /NETNAME:CSDNET                             \
  /LUNAME:M1R01LUA                            \
  /COMMENT:""                                 \
  /AUTOPARTNER:No                             \
  /DEFAULTPOOL:No                             \
  /TPTIMEOUT:60                               \
APPCLLU M1R01LUA                              \
  /ADDPARTNER:M1CDXY2B,NDM624K,TOKEN1         \
APPCLLU M1R01LUB /ADD                         \
  /SERVER:CSD-NTSNA1                          \
  /LUNUMBER:0                                 \
  /NETNAME:CSDNET                             \
  /LUNAME:M1R01LUB                            \
  /COMMENT:""                                 \
  /AUTOPARTNER:No                             \
  /DEFAULTPOOL:No                             \
  /TPTIMEOUT:60                               \
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APPCLLU M1R01LUB                              \
  /ADDPARTNER:M1CDXX2B,NDM624K,TOKEN1         \
USER USER1 /ADD                               \
  /DOMAIN:CSD-NTSNA1                          \
  /COMMENT:""                                 \
USER USER1                                    \
  /INSERT:M1R01LU2                            \
USER USER1                                    \
  /INSERT:M1R01LU3                            \
DIAGNOSTIC                                    \
  /AUDITLEVEL:10                              \

Access Communications Server Configuration Listing

The SNA configuration listing for IBM Communications Server is stored in a file with an extension of acg.
The name for this file is defined when you install the Communications Server.

SNA Server/Host Configuration Worksheet

Complete this worksheet before you set up and configure an SNA connection between the host and the SNA
server.

For each parameter listed, record the parameter value mapped between SNA and VTAM. Use the alphabetic
identifier to understand how the parameters are implemented in the network map in the example.

Host/VTAMParameter value Mapped
Between SNA and VTAM

ParameterIdentifier

LOCAL.NODELocal Connect:Direct node
name=

[a]

ADJACENT.NODERemote Connect:Direct node
name=

[b]

LOGMODEMode=[c]

VTAM APPLID DSESSLIMSession Limits=[d]

LOGMODE RU SizeMax RU=[e]

VTAMNETID (owner of PU)Server Netname=[f]

VTAM PU NameServer CPNAME=[g]

VTAM SSCPNNAMEConnection CPNAME=[h]

VTAM NETID (owner of PU)Connection Netname=[i]

VTAM PU DBLKConnection
LOCALBLOCKNO=

[j]

VTAM PU IDNUMConnection
LOCALNODENO=

[k]

Remote Network AddressConnection
REMOTENETADDR=

[l]
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VTAM LU Name (must be
independent)

Local LU Name (APPCLU)=[m]

VTAM NETID (owner of PU)APPCLU Netname=[n]

VTAM APPLIDRemote Partner LU
(APPCRLU)=

[o]

VTAM NETID (owner of
APPLID)

APPRCLU Netname=[p]

Get Support for Sterling Products

Sterling Commerce provides intuitive technical products and superior Help and documentation to enable you
to work independently. However, if you have a technical question regarding a Sterling Commerce product,
use the Sterling Commerce Customer Support Web site.

The Sterling Commerce Customer Cemter portal offers you a single location to administer everything associated
wtih Sterling Commerce products and services.

To log in to Customer Center, go to http://customer.sterlingcommerce.com. If you do not have a password,
click Join Now and follow the instructions for new users. If you have a Support on Demand account, define
a new password the first time you log on.

Connect:Direct for Windows Documentation

The Connect:Direct for Windows library consists of the following:

• Getting Started with Connect:Direct Windows provides instruction to install Connect:Direct Windows,
including pre-installation information and installation tasks.

• Connect:Direct Windows System Guide provides instruction to set up and use Connect:Direct for Windows.
• Connect:Direct Windows Release Notes includes product updates and compatibilities, last-minute changes,

instructions for downloading the product from the ESD Portal, known restrictions, enhancements, and
installation notes.

• Connect:Direct Windows Maintenance Updates contains the latest product maintenance.

The following manuals supplement the Connect:Direct Windows documentation:

• Connect:Direct Process Language Web site provides an overview of Connect:Direct, describes the general
structure and syntax rules for the Process language, and includes numerous examples. It describes the Process
statements for various platforms including Connect:Direct.

• Connect:Direct Compatibility and Connectivity Chart provides definitions for the supported Connect:Direct
platforms and the mapping of definitions that must match between two communicating platforms.

• Connect:Direct for Windows Secure+ Option Implementation Guide provides installation and configuration
information for Secure+ Option.

• Connect:Direct SDK Programmer’s Guide provides system programmers and system developers with the
information needed to extend the capabilities of the Connect:Direct environment.
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Install Connect:Direct for Windows

Install Connect:Direct for Windows: Overview

After you complete the installation worksheets, you are ready to install Connect:Direct for Windows.

Install all components or selected components. Connect:Direct components include:

• Connect:Direct for Windows server—Performs the functions issued from the user interface. If you want a
dedicated server, install only this component. It also includes the Command Line Interface (CLI), a tool that
allows you to issue commands to the server.

• Connect:Direct for Windows Requester—A graphical user interface that makes it easy to configure the
Connect:Direct environment, create Processes, and submit commands to the server.

• Connect:Direct File Agent—Scans watched directories for files. When a file is detected, Connect:Direct for
Windows either submits a default Process to Connect:Direct or performs the actions specified by the rules
for the file.

• Connect:Direct Secure+ Option—A separately purchased option that allows you to implement security into
a Connect:Direct operation. Secure+ must be installed on both nodes in order to activate the security software.

Software Developer’s Kit (SDK) is a separately purchased option that allows programmers to customize the
functions of Connect:Direct for Windows.

After you install Connect:Direct for Windows, TCP/IP information, database information and notification
method is defined in the initialization parameters. To change TCP/IP information, the notification type, or the
Connect:Direct database, refer to the Connect:Direct for Windows System Guide.

Connect:Direct for Windows Installation Icons

You choose the installation type to meet your needs. For example, if you want to install a standalone server,
install only the Connect:Direct for Windows server software. If you want to use a computer as a server and a
workstation, install both the server software and Connect:Direct Requester. If you purchase Secure+ Option,
use the custom installation to install both Connect:Direct for Windows and Secure+ Option.

Additionally, if you have a large network of computers where you need to install Connect:Direct for Windows,
you can set up a silent installation. To configure a silent installation, install Connect:Direct for Windows at
one computer. Then use the initialization parameters file that was created during the installation to create a
silent installation. Send the modified INI file to each computer on which to perform the silent installation.
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Icons are displayed by each component to illustrate the selected installation type. The icons and installation
types are described below:

The component is installed to the local drive.

Selected features of the component are installed.

The component is not installed.

Adds an icon to the Connect:Direct program group of the selected computer. The
component is only installed when the user clicks the program icon to run the
program.

The component is installed on the network.

Connect:Direct is installed in the directory called X:\Program Files\Sterling Commerce\Connect Direct
v4.5.00\component.

If you would like to install Connect:Direct for Windows in another location, select the Custom setup during
the installation and click Change. The remaining procedures use the default installation path.

Apply a Temporary or Permanent License Key

The temporary and permanent license key files must be applied where Connect:Direct for Windows is installed.

To apply a license key:

1. Copy the temporary license key file from the Sterling Commerce e-mail to the C:\Program Files\Sterling
Commerce\Connect Direct 4.5.00\server directory.

2. Rename the license key file to license.key.

Note:  Do not edit the nnnnn.txt file or the license.key file.

Text editors may insert a carriage return or truncate lines, which will invalidate the key file.

3. To obtain a permanent license key, use the CD System ID Utility to gather needed information. To run the
CD System ID Utility:

a) Click Start > Programs > Sterling Commerce Connect:Direct v4.5.00 > CD System ID Utility. The
Utility displays the CPU-ID and number of processors.

b) Click File > Save.
c) Type a name for the file and click Save.
d) Click File > Send email.
e) Type requested information in the e-mail template and click Send.

You will receive the permanent license key file in approximately 24 to 48 hours.

4. Make a copy of the original permanent license key and keep it in a safe place.

5. To replace the temporary license key with the permanent license key file, repeat steps 1 and 2.

Start the Installation

To start the Connect:Direct for Windows installation:
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1. Insert the CD into the CD drive or double-click the setup.exe file extracted from the ESD file download.

2. If Autorun is enabled, the installation automatically starts. If Autorun is disabled, start the setup.exe file
from the Windows run option.

3. On the Welcome dialog, click Next.

4. On the License Agreement page, read the agreement and click I accept the terms of the license agreement
to continue. Click Next.

5. To install Connect:Direct Server and Requester, select Typical. Click Next.

6. To install Connect:Direct for Windows and Secure+ Option, select Custom. Click Next. This is the preferred
method.

Install Connect:Direct Server and Requester

Start the installation and select Typical before you begin this procedure.

To complete the server and Requester installation:

1. Select Default from the Configure dialog box.

2. Click Browse and locate the license file you received from Sterling Commerce. Click Next.
The license file is copied to C:\Program Files\Sterling Commerce\Connect Direct v4.5.00\server.

3. Click Install.

4. Click OK.

5. When the installation is finished, Connect:Direct Requester is automatically started. If you do not want it
to start, uncheck the option.

6. Click Finish.

Complete the Connect:Direct for Windows and Secure+ Option Installation

Start the installation and select Custom before you begin this procedure.

To complete a custom installation of Connect:Direct for Windows:

1. After you select Custom and click Next, the Custom Setup dialog box is displayed. The Connect:Direct for
Windows Server and Requester software will be installed automatically.

2. To install Secure+ Option, click the icon next to it and select the installation method

3. To install SNMP Extension Agent, click the icon next to it and select the installation method.

4. To change the default installation path of Connect:Direct for Windows from C:\Program Files\Sterling
Commerce\Connect Direct v4.5.00. highlight Server and click Change. Select the installation location and
click OK.

5. After selecting the components to install, click Next.

6. From Configure Connect:Direct for Windows Server dialog box, click Next.

7. To change the local node name where Connect:Direct is installed, type the alternate node name and click
Next.

8. From the License Management dialog box, click Browse and select the license file you received from
Sterling Commerce. Click Next.
The license file is copied to the C:\Program Files\Sterling Commerce\Connect Direct v4.5.00\server folder.

9. To configure SQL Server to capture statistics, messages, and TCQ information:
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Select the SQL server to use with Connect:Direct.•
• Identify the authentication method: Windows authentication or Microsoft SQL Server using the specified

User ID and Password. Click Next.

10. To specify an optional user account to run the Connect:Direct service, click Enter an optional service logon
account. Type the following information and click Next.

• Service Account name
• Service Password
• Verify the password

Note:  InWhen setting up the logon account, give the account these privileges:

• Act as part of the operating system
• Log on as a service
• Log on locally
• Replace a process-level token
• Full permissions over the installation directory, typically "Program Files\Sterling Commerce\Connect

Direct v4.5.00"
• Make the user a member of the local Administrators Group

11. To configure TCP/IP as the connection method, provide the following information and click Next:

• Node-to-Node IP Address
• Node-to-Node Port
• User Interface IP Address
• User Interface Port

12. If you installed SNA, do the following to configure SNA support:

a) Select Configure SNA.
b) Type the local LU name in the Local LU Name field.
c) Type the network name or ID in the Network Name (NET ID) field.
d) Type the mode name in the APPC Mode Name field.
e) Click Next.

13. To use Active Directory, select Register Client Connection Settings and click Next.

14. To configure SNMP support:

a) To enable the SNMP extension agent, select Enable Connect:Direct SNMP Extension Agent.
b) To enable event logging, select Enable SNMP Event Logging.
c) Click Next.

15. To configure notification support:

a) To enable Windows broadcasting, select NT Network Broadcast.
b) To enable SMTP, select SMTP.
c) Click Next.

16. To use a network map or user authorities that you defined for previous versions of Connect:Direct, click
Browse and select the network map to import or configuration file to import. Click Next.

17. Click Install.

23Sterling Commerce, Inc.



18. If you installed Connect:Direct Requester, it starts automatically. To disable the automatic start, deselect
this option. Click Finish.

Upgrade Connect:Direct for Windows

To upgrade Connect:Direct:

1. Double-click the setup.exe file.

2. On the Welcome dialog, click Next.

3. To upgrade Connect:Direct, select Upgrade. Click Next.

4. To save the previous version of Connect:Direct, check Keep <version - nodename>." Click Next.

5. Click Install.

6. If you installed Connect:Direct Requester, it starts automatically. To disable the automatic start, deselect
this option. Click Finish.

Add Connect:Direct for Windows Components

Before you can add a component, you must have already installed Connect:Direct for Windows.

After you install the product, you can change the installed components including repair a component that is
corrupt, remove a component, or install an additional component.

To add, remove, or repair a Connect:Direct component:

1. Start the Connect:Direct for Windows installation.

2. On the Welcome dialog, click Next.

3. To install additional components:

a) Select Modify and click Next.
b) Select the component to add and enable This feature will be installed on local hard drive." Click Next.
c) Click Install.
d) Click Finish.

Repair Connect:Direct for Windows Components

Before performing this procedure, first you must have installed Connect:Direct for Windows.

To repair Connect:Direct for Windows components:

1. Start the Connect:Direct for Windows installation.

2. On the Welcome dialog, click Next.

3. Select Repair and click Next

4. Click Install to repair the installation.

5. Click Finish to complete the modification.
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Remove Connect:Direct for Windows Components

Before performing this procedure, first you must have installed Connect:Direct for Windows.

To remove a Connect:Direct for Windows installed component:

1. Start the Connect:Direct for Windows installation.

2. On the Welcome dialog, click Next.

3. Select Modify to remove a Connect:Direct component and click Next.

4. Select the component to remove, choose "This feature will not be available," and click Next.

5. Click Install.

6. Click Finish to complete the modification.

Install Requester Only

For cluster installations, computers other than the one on which Connect:Direct is installed may require that
the Requester.

To install Connect:Direct Requester:

1. Insert the Connect:Direct Requester CD into the CD drive or double-click the setup.exe file extracted from
the file downloaded from the ESD Portal.

2. If the Autorun option is enabled for the CD drive, the installation automatically starts. If the Autorun option
is disabled, start the installation from the Windows Run dialog.do the following:

3. On the Welcome dialog, click Next.

4. Read the agreement and indicate acceptance by clicking I accept the terms of the license agreement.

5. Click Next.

6. On the Setup Type dialog, select Typical and click Next.

7. Click Install.

Install Connect:Direct File Agent

When you install Connect:Direct File Agent, Java Runtime Environment (JRE) is automatically installed.

To install File Agent:

1. Insert the Connect:Direct for Windows CD into the CD drive, or locate the files you extracted from the
ESD Portal, and double-click the FileAgentInstall.exe file.

2. From the Introduction dialog box, click Next.

3. If you want to install File Agent in a selected location, click Choose and identify the location for the File
Agent installation.

4. Click Next, then click Install.

5. When the installation is complete, click Done.
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Uninstall Connect:Direct for Windows

Before performing this procedure, first you must have installed Connect:Direct for Windows.

The Connect:Direct for Windows Uninstall program removes the application, its components, Connect:Direct
Requester, and Connect:Direct for Windows server, program items, and most server and Registry settings.

To uninstall the Connect:Direct Server program and all of the server utilities, perform the following steps:

1. Click Start > Programs > Settings > Control Panel > Add-Remove Programs.

2. Highlight Connect:Direct for Windows and click Remove.

3. Click Yes to confirm the removal of this program.

4. Click Finish to complete the uninstallation.

5. Click OK to close the Add/Remove Programs Properties dialog box.

Add Initialization Parameters to Support Firewall Navigation

If you communicate with a trading partner using a firewall, set two initialization parameters to support it. You
assign a specific TCP/IP source port number or a range of port numbers with a particular TCP/IP address or
addresses for outgoing Connect:Direct sessions. Setting these parameters allows controlled access to a
Connect:Direct server if it is behind a packet-filtering firewall without compromising security.

To add firewall support initialization parameters:

1. Coordinate IP addresses and associated port assignments with your firewall administrator.

2. Add the following parameter to the Local Node Characteristics section of the initialization parameters file:

tcp.src.ports=(valid IP address/optional subnet mask | valid IP address pattern, associated port number |
associated range of port numbers | associated port number, associated range of port numbers)

3. Apply the new initialization parameter.

4. A second parameter called tcp.src.ports.list.iterations is automatically added to the Local Node Characteristics
section during installation and has a default value of 1. Refer to the following table for a description and
valid values for these parameters:

Valid ValuesParameter DefinitionParameter Name

Valid IP address with an optional mask
for the upper boundary of the IP

An IP address or multiple addresses
and the ports permitted for the address
when going through a packet-filtering
firewall.

tcp.src.ports

address range and the associated
outgoing port number or range of port
numbers for the specified IP address,
for example:

(199.2.4.*, 1024), (fd00:0:0:2015:*::*,
2000-3000), (199.2.4.0/255.255.255.0,
4000-5000),(fd00:0:0:2015::0/48,
6000, 7000)

A wildcard character (*) is supported
to define an IP address pattern. If the
wildcard character is used, the optional
mask is not valid.
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Valid ValuesParameter DefinitionParameter Name

A numeric value from 1-255. The
default value is 1.

The number of times that
Connect:Direct scans the list of
available ports defined in tcp.src.ports

tcp.src.ports.list.iterations

to attempt a connection before going
into a retry state. This parameter is
automatically added to the initialization
parameter and is assigned a value of
1. If desired, change this value.

5. Coordinate the specified port numbers with the firewall administrators.

Firewall Configuration Example

The following example illustrates a configuration of the firewall navigation initialization parameter. An
explanation follows the example. Although the tcp.src.port parameter is shown as a multi-line parameter,
Connect:Direct for Windows only supports single-line parameters.

tcp.src.ports= (199.2.4.*, 5000-5050),
      (199.2.4.7, 1376),
      (200.200.0.0/255.255.0.0, 2000-2100, 3000-3100),
      (138.16.17.*, 2000-2050, 3000-3050, 4001, 4005) 

In the example, if Connect:Direct initiates a session with a remote node at the IP address 199.2.4.7, it will use
only port 1376. A session 199.2.4.6 (or any other address beginning with 199.2.4) will use any port in the
range 5000 to 5050.

A session to 200.200.4.10 uses a port from within the two ranges specified (2000 to 2100 or 3000 to 3100).
Additionally, because of the subnet mask specification, a session to any IP address beginning with 200.200
will choose a port from within the two ranges specified.

The port for a session to any address beginning with 138.16.17 is selected from one of the two ranges (2000
to 2050 or 3000 to 3050) or the two individual ports specified (4001 or 4005).
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Automate Installation

About Silent Installations

You can automate Connect:Direct for Windows installation and configuration for distribution throughout your
enterprise by performing silent installations. Silent installations require no user responses during the installation
routine. Configuration information is supplied by the initialization file that you define. Before you perform a
silent installation, install Connect:Direct for Windows on a master node and configure a network map and user
authorizations.

The Microsoft Installer Properties are the foundation of a silent installation. Properties can be set on the
command line or by creating custom transforms. A transform is a collection of changes applied to an installation.
Transforms alter the installation database and can be used to customize a base installation package. Applying
a transform to a base installation package adds or replaces data in the installation database.

Silent Installation Options

You can perform a default silent installation that installs Connect:Direct server and Connect:Direct Requester,
or you can use transforms to modify the settings of an installation package. The transforms included with this
product enable, disable, and remove a feature from the Connect Direct for Windows.msi package. To change
the silent installation setting, use a transform to enable or disable the desired feature.

Requirements for Silent Installation

Use the following list as a guide to the silent installation requirements for each node:

• To perform the default installation (server and Connect:Direct Requester), the node must have a license key.
• To install only Connect:Direct Requester or SDK, no license key is required.
• If the node uses special services, for example, Active Directory, SNMP, or SNA, a custom INI file is required.

If no custom INI file is present, the default installation is performed.

Customize Initialization Information for a Silent Installation

The Connect:Direct server supports an INI file, which can specify the value of installation properties. If you
plan to use the INI file to manage a silent installation, change the parameters of the INI file provided with
Connect:Direct for Windows to specify site-specific information.
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The Connect:Direct for Windows server initialization file (CD_SRVR.INI) is located on the CD in the /advanced
folder. The Connect:Direct Requester and SDK installations do not use initialization files. To set the installation
directory for an installation, specify the INSTALLDIR property in the command line.

To define site-specific parameter values in an INI file for each node where you install Connect:Direct for
Windows using the silent installation, do the following:

1. Open the CD_SRVR.INI file using any text editor, such as Windows Notepad.

2. Define the site-specific initialization parameters for a node and save the file.

3. Repeat steps 1–2 for each server where Connect:Direct will be installed.

CD_SRVR.INI Parameter Values

ValuesParameter DefinitionParameter Name

Default | Custom | UpgradeInstallation type: Default, Custom, or
Upgrade.

CD_SETUP_TYPE

SQL authentication.CD_SQL_AUTHENTICATION

Service account name to log on with.CD_SQL_USERID

Password to log on with.CD_SQL_PWD

If this field is blank, the parameter
defaults to the first eight characters of

Local node name, from 1-16 characters,
consisting of numbers, letters, @, #, $,

CD_NODENAME

the computer where the server is
installed.

-, underscore (_), and period (.) with no
spaces or apostrophes.

1=enabled.The version of software and node to
upgrade.

CD_UPGRADE_NODE

1=enabled
Prevents the current version from being
deleted before installing the new
version.

CD_UPGRADE_KEEPSCR_FLAG

The type must be equal to UPGRADE.

X:\Program Files\Sterling
Commerce\Connect Direct \x.x.xx | Any
valid Windows directory

The location of the license file.CD_LICENSE_FILE

Any valid IP address.The IP address of the host server.CD_HOST_IP

A numeric value in the format nnnn,
where nnnn is a positive integer no

The port number that Connect:Direct
for Windows, or user-written API

CD_HOST_PORT

larger than four digits. The default is
1364.

programs, will use to establish client
sessions with this Connect:Direct server
for outgoing communications.

Valid TCP/IP address. If blank, the IP
address is obtained from the destination

The host IP address. Any valid TCP/IP
address may be specified.

CD_API_IP

computer’s IP address in the TCP/IP
stack.

A numeric value in the format nnnn,
where nnnn is a positive integer no

The port number that Connect:Direct
for Windows or user-written API

CD_API_PORT

larger than four digits. The default is
1363.

programs will use to establish client
sessions with this Connect:Direct
server.You must specify the port when
it differs from the default.
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ValuesParameter DefinitionParameter Name

1=enabledIndicates whether SNA connectivity is
supported.

CD_SNA_FLAG

Valid 1-8 character LU name or
computer name up to 8 characters.

The local LU name to use during SNA
communications, or the name of the
computer, if no LU name is specified.

CD_SNA_LUNAME

A valid 1-8 character network ID.The SNA network ID.CD_SNA_NETID

ndm624K | a valid 1-8 character mode
name

The SNA mode name.CD_SNA_MODE

1=enabledEnables SNMP.CD_SNMP_FLAG

1=enabledEnables SNMP Event log.CD_EVENTLOG_FLAG

1=enabledRegisters the client IP address to active
directory.

CD_ACTIVEDIR_FLAG

NT Broadcast | SMTPDefines the notification type to use.CD_NOTIFY_TYPE

Host address in the format xxx.xxx.xxxIf CD_NOTIFY_TYPE = SMTP, this field
identifies the IP address of the SMTP
host.

CD_NOTIFY_SMTP_HOST

Port number up to four characters. The
default value is 25.

If CD_NOTIFY_TYPE = SMTP, this field
identifies the port used by the SMTP
host.

CD_NOTIFY_SMTP_PORT

Valid e-mail addressIf CD_NOTIFY_TYPE = SMTP, this field
identifies the e-mail address to identify
the sender of the message

CD_NOTIFY_SMTP_SENDER

1=enabledIf CD_NOTIFY_TYPE = SMTP, this field
enables authentication. If this value is

CD_NOTIFY_SMTP_AUTHENTICATE

not set, the user ID and password fields
are ignored.

A valid user ID.If CD_NOTIFY_TYPE = SMTP, this field
identifies the user ID to use to
authenticate the server.

CD_NOTIFY_SMTP_USERID

A valid user password.If CD_NOTIFY_TYPE = SMTP, this field
identifies the user password to use to
authenticate the server.

CD_NOTIFY_SMTP_PWD

X:\Program Files\Sterling
Commerce\Connect Direct

The path name and file name to the
user authority file.

CD_USERAUTH_FILE

\x.x.xx\MyUserAuthSettings.cfg | Any
valid Windows directory and user
authority file name

X:\Program Files\Sterling
Commerce\Connect Direct

The path name and file name of the
network map file.

CD_NETMAP_FILE

\x.x.xx\mynetmap.map | Any valid
Windows directory and network map file
name

Service user account.CD_SVC_ACCOUNT

Service user account password.CD_SVC_ACCOUNT_PWD

Valid SQL ServerThe name of a valid SQL Server.CD_SQL_SERVER

SQL authentication.CD_SQL_AUTHENTICATION
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ValuesParameter DefinitionParameter Name

Valid SQL Server System Administrator
user ID

SQL Server system administrator’s user
ID.

CD_SQL_USERID

Valid 1-30 character SQL Server
System administrator password

SQL Server system administrator’s
password.

CD_SQL_PWD

Customize Connect:Direct for Windows Configuration Information

After you install Connect:Direct for Windows on a master node, you can customize configuration information
for distribution within your enterprise by using Connect:Direct Requester to configure the network map and
user authorizations on the master node. You can then extract those files using the Configuration Utility. For
more information about using the Configuration Utility, refer to "Defining and Managing the Connect:Direct
Network" in Help or in the Connect:Direct for Windows System Guide.

To apply the customized configuration files during a silent installation, set parameter values in the CD_SRVR.INI
file as follows:

• To apply a customized network map file, set CD_NETMAP_FILE to the fully qualified path to a customized
network map configuration file.

• To apply a customized user authorization file, set CD_USERAUTH_FILE to the fully qualified path to a
customized User Authorization configuration file.

Run a Silent Installation

Setup.exe installs the Microsoft Installer, Visual C++ Runtime Libraries and other prerequisites on a system
when they do not already exist. To complete the installation, Setup.exe reboots the system if required and
resumes the installation after the computer has restarted.

Setup.exe can accept a limited number of command-line parameters. By using these parameters, you can pass
parameters through Setup.exe to the included .msi file (MsiExec). To pass arguments to the .msi file, use the
/v option. Once you specify this option, you can list any of the supported parameters that can be passed to
Msiexec.exe.

If you don't want the Setup.exe to display a progress bar when it launches, use the /s command-line parameter.
For example, if you enter Setup.exe /s, Setup.exe launches, but the user interface is not displayed. If you want
the .msi setup to run silently as well, you'll need to pass the /qn command-line parameter through Setup.exe
using the /v parameter—for example: Setup.exe /s /v/qn

Follow these special formatting rules when passing a parameter in this way. First, place a backslash (\) character
before a quotation mark that resides within existing quotes. For example, the command line above contains
the following: /v"C:\My Files\SecurePlusEnable.mst\". Because the path contains spaces, you must use quotes.
However, since quotes are required around the complete argument, if you don't use the backslash before internal
quotes, the command-line statement fails.

Do not put a space between the command-line option (/v) and the arguments you are passing. This rule is also
illustrated in the above example.

Finally, if you are passing multiple parameters using the /v option, separate them with a space. For example,
the following command enables Secure+ Option and specifies the license file:

Setup.exe /s /v"C:\My Files\SecurePlusEnable.mst\" CD_LICENSE_FILE=\"C:\My Files\license.key\""
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To attach to the network and install Connect:Direct for Windows features from the network location in a silent
installation:

1. Click Start > Run. The Run dialog box is displayed.

2. In the Open field of the Run dialog box, type a command similar to following example: Setup.exe /s /v/qn
This command installs all Connect:Direct for Windows components including Connect:Direct Requester
and Secure+ Option.

Note:  Setup.exe installs Connect:Direct for Windows in the default directory c:\Program Files\Sterling
Commerce\Connect Direct Windows v[current version]. If you want to install Connect:Direct for Windows
in a different directory, use the INSTALLDIR option on the command line. Enclose the pathname in quotes
and terminate the path with a backslash, such as Setup.exe /v"INSTALLDIR=\"D:\Program Files\Sterling
Commerce\Connect Direct v4.5.00\"" .

3. Computers in a Windows 2000 or XP Domain that use Active Directory can also automate installations
using the software installation extension of the Group Policy Snap-In.

The Windows installer uses an /M command line parameter to generate MIF files. In the following example,
the CDNT.mif file is created to report success or failure: setup.exe /s /v/qn /M C:\Windows\CDNT.mif

Perform an Unattended Uninstallation

Connect:Direct for Windows provides for an unattended uninstallation. In the following example, the /x
command parameter removes the package.

Setup.exe /x
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